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CHƯƠNG TRÌNH ĐÀO TẠO MICROSOFT WORD 2007 

PHẦN I: TỔNG QUAN VỀ CHƯƠNG TRÌNH 

I. GIỚI THIỆU VỀ MICROSOFT WORD2007. 

Chương trình soạn thảo Microsoft Word là một phần mền thuộc bộ chương trình 

Microsoft Office nổi tiềng của hãng Microsoft. Đây là chương trình soạn thảo trực 

quan, có giao diện đẹp, thân thiện và dễ sử dụng. Với nhiều tính năng mạnh mẽ, 

Microsoft Word2007 thực sự là một công cụ soạn thảo chuyên nghiệp không thể 

thiếu trong các ứng dụng văn phòng. 

II. CÁCH KHỞI ĐỘNG, THOÁT CHƯƠNG TRÌNH. 

1. Khởi động chương trình. 

- Click chuột vào nút: Start / Program / Microsoft Office / Microsoft Word 

2007. 

- Click Double trái chuột vào biểu tượng   trên Desktop . 

2. Thoát chương trình. 

- Cách 1: Click chuột Office Button / Close. 

- Cách 2: Click chuột vào biểu tượng   (close) phía trên và ở  góc phải cửa sổ 

làm việc. 

- Cách 3: Sử dụng tổ hợp phím Alt + F4. 

� Lưu ý: 

- Nếu File văn bản chưa được lưu lên đĩa hoặc có sự thay đổi nhưng chưa được lưu 

lên đĩa, khi thoát sẽ xuất hiện hộp thoại cho phép có lưu lại những thay đổi không.  

 

Hình 1.1 Hộp thoại  lưu tài liệu 
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- Nếu chọn ( Yes ) sẽ lưu lại những thay đổi, chọn ( No ) để thoát, chọn ( Cancel ) 

để hủy bỏ thao tác. 

III. CÁC THAO TÁC QUẢN LÝ TÀI LIỆU 

 ở ộ ệ ớ

- Cách 1: Nhấn tổ hợp phím Ctrl + N hoặc Click chuột vào biểu tượng  trên 

thanh công cụ Ribbon. 

- Cách 2: Vào Office Button / chọn New / chọn Blank document / chọn Create. 

 ở ộ ệ ẵ ổ

- Cách 1: Sử dụng tổ hợp phím Ctrl + O, hoặc Click chuột vào biểu tượng  

trên thanh Ribbon. 

- Cách 2: Vào Office Button / chọn Open. 

3. Lưu một tài liệu. 

- Cách 1: Sử dụng tổ hợp phím Ctrl + S, hoặc Click chuột vào biểu tượng  

trên thanh Ribbon. 

- Cách 2: Vào Office Button / chọn Save hoặc Save as…. 

 

H×nh 1.2 Hộp thoại lưu tài liệu 

����  Save in : Chọn ổ đĩa -> Chọn thư mục lưu giữ văn bản. 

����  File name : Đặt tên cho văn bản lưu. 
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����  Save as type : Kiểu định dạng tài liệu. 

����  Save : Lưu lại nội dung văn bản. 

IV. GIỚI THIỆU CỬA SỔ LÀM VIỆC. 

1. Cửa sổ làm việc. 

 

Hình 1.3 Cửa sổ làm việc Microsoft Word 2007 

2. Chức năng thanh thực đơn : 

- Home: Gồm các công cụ định dạng trong văn bản như: Font, paragraph, copy, 

paste, Bullets and numbering….. 

- Insert: Cho phép chèn các đối tượng vào trong văn bản như: chèn Picture, 

WordArt, Equation, Symbol, Chart, Table, Header and footer, Page number, ... 

- Page Layout: Các thiết lập cài đặt, định dạng cho trang giấy như: Page setup, 

Page Borders, Page Color, Paragraph,…….. 

- Reference: Các công cụ liên quan định dạng văn bản như : Chèn chú thích, 

đánh mục lục tự động, … 

- Maillings: Thanh công cụ trộn thư. 

- Review: Các chức năng kiểm tra lại như ngữ pháp, chính tả… 
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- View: Làm việc với hiển thị màn hình. 

- Developer: Thiết kế  và mở rộng. 

- Add-ins: Các ứng dụng bổ trợ. 

V. CÁCH GÕ TIẾNG VIỆT VÀ MỘT SỐ PHÍM CHỨC NĂNG. 

1. Cách gõ dấu tiếng việt. 

- Để có thể gõ được tiếng việt có dấu người ta phải sử dụng các phần mềm gõ 

tiếng việt, phần mềm gõ tiếng việt thông dụng hiện nay đó là: Vietkey hoặc 

Unikey. 

 

 

 

 

 

 

 

 

 

 

2. Một số phím chức năng. 

 Tab  Lùi văn bản vào với một khoảng cách cố định. 

 Caps Lock Viết chữ hoa. 

 Shift + Chữ cái Viết chữ hoa. 

 Backspace Xóa ký tự phía trước con trỏ. 

 Delete Xóa ký tự phía sau con trỏ. 

 Home  Di chuyển con trỏ về đầu dòng. 

 End  Di chuyển con trỏ về cuối dòng. 

 Page up Chuyển con trỏ lên phía trên 1 trang màn hình. 

 Page Down Chuyển con trỏ xuống phía dưới 1 trang. 

Bảng chữ cái 

ă aw 

â aa 

ê ee 

ư uw 

ô oo 

ơ ow 

đ dd 

Bảng dấu 

Huyền F 

Sắc S 

Hỏi R 

Ngã X 

Nặng J 

Bảng gõ dấu và chữ cái tiếng việt kiểu Telex 
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PHẦN II: QUY TRÌNH TẠO RA MỘT VĂN BẢN HOÀN CHỈNH. 

I. THIẾT LẬP TRANG GIẤY 

1. Giới thiệu thiết lập trang soạn thảo. 

- Trước khi soạn thảo công việc định hướng cho khung văn bản soạn thảo là 

việc rất quan trọng. Chúng ta phải xác định văn bản ưu tiên theo chiều ngang 

hay dọc, định dạng kích thước của lề, khổ giấy soạn thảo... Vì vậy ta phải tiến 

hành cài đặt trang văn bản trước khi soạn thảo. 

2. Cách thực hiện. 

 Định dạng trên thanh công cụ: 

- Trên thanh Ribbon -> chọn thực đơn Page Layout. 

 

 

 

 

� Margins: §Þnh d¹ng lÒ giÊy. 

� Orientation: Chän chiÒu trang giÊy. 

� Size: Chän khæ giÊy. 

 Định dạng bằng hộp thoại Page setup. 

- Vào Ribbon/ Page Layout / Page setup. Xuất hiện hộp thoại Page setup. 

Click chuột 

Hộp thoại 

Page Setup 

Hình 2.1 thanh thực đơn page layout 
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MARGIN PAPER 

 Top : Đặt lề trên. Page size : Chọ khổ giấy (A4). 

 Bottom : Đặt lề dưới. Orientation. 

 Left : Đặt lề trái. - Portrait : Đặt giấy dọc. 

 Right : Đặt lề Phải. - Landscape : Đặt giấy ngang. 

 ĐỊNH DẠNG FONT CHỮ VÀ CĂN CHỈNH DỮ LIỆU.

1. Định dạng Font chữ. 

- Bôi đen vùng văn bản cần định dạng. Chọn Home / Font hoặc ấn tổ hợp phím 

Ctrl + D. Hộp thoại Font xuất hiện: 

 

Hình 2.2 Hộp thoại Page setup 

Hình 2.3 Hộp thoại định dạng Font 
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� Font: Định dạng căn bản về Font chữ. 

� Font Style: Lựa chọn kiểu chữ: chữ đậm (Bold), chữ nghiêng (Italic), chữ vừa 

đậm và nghiêng ( Bole Italic). 

� Size: Chọn kích cỡ chữ. Sau khi chọn xong nhấn (OK ) để xác nhận lựa chọn, 

(Default ) để mặc định , (Cancel ) để hủy bỏ thao tác. 

� Font Color: Chọn màu của chữ. 

- Nhấn  chọn định dạng Font chữ trên thẻ Home. 

              

 

 

 

2. Căn chỉnh dữ liệu. 

- Bôi đen đoạn văn bản cần định dạng. 

- Trên thanh Ribbon / chọn thẻ Home. 

 

 

Hình 2.5 thanh công cụ căn chỉnh dữ liệu 

   Căn trái  Căn giữa 

  Căn phải  Căn đều hai bên 

  Chữ đậm  Chữ nghiêng 

  Chữ gạch chân 

Chữ nghiêng 

Chọn font 

Chữ gạch dưới Chữ đậm 

Cỡ chữ 

Hình 2.4 thanh công cụ định dạng Font 

Màu chữ 
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 ĐỊNH DẠNG ĐOẠN VĂN

1. Giới thiệu về Paragraph. 

- Điều chỉnh khoảng cách giữa các đoạn, các dòng trên văn bản. 

2. Cách thực hiện lệnh định dạng đoạn văn. 

- Bôi đen đoạn văn bản cần định dạng. Vào Home -> Chọn Paragraph -> xuất 

hiện hộp thoại Paragraph. 

 

 

   Hình 2.6 Hộp thoại định dạng đoạn văn. 

- Trong mục Spacing bao gồm: 

� Before: Khoảng cách giữa đoạn định dạng với đoạn trên nó. 

� After: Khoảng cách giữa đoạn định dạng với đoạn sau nó. 

� Line Spacing: Khoảng cách giãn giữa các dòng. 

- Trong mục Indentation: 

 � Left: Điều chỉnh khoảng cách của lề trái đến văn bản. 

 � Right: Điều chỉnh khoảng cách của lề phải đến văn bản. 

 � Special:  
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 + First line: Thụt chữ cái dòng đầu đoạn văn một khoảng trong (By). 

 + Hanging: giữ nguyên dòng đầu, áp dụng cho toàn đoạn văn sau nó thụt 

một khoảng (By). 

- Alignment: Định dạng vị trí con trỏ trong văn bản. 

- Outline Level: Vị trí, cấp của đường được chọn. 

IV. MỘT SỐ PHÍM SỬ DỤNG TRONG VĂN BẢN. 

Mở văn bản có sẵn 

 Ctrl + F4 Đóng tài liệu đang mở 

 Ctrl + N Tạo mới văn bản 

 Ctrl + S Lưu một văn bản. 

 Alt + F4 Thoát khỏi chương trình. 

 Ctrl + D Mở hộp thoại định dạng Font chữ. 

 Ctrl + B Chữ đậm. 

 Ctrl + I In nghiêng 

 Ctrl + U Gạch chân dưới chân các ký tự. 

 Ctrl + L Căn lề trái. 

 Ctrl + E Căn giữa. 

 Ctrl + R Căn phải. 

 Ctrl + J Căn đều hai bên. 

 Ctrl + Shift + “=” Tạo chỉ số trên. 

 Ctrl + “ = ” Tạo chỉ số dưới. 

 Ctrl + 1 Điều chỉnh khoảng cách giữa các dòng là  

   một ( Single). 

 Ctrl + 2 Điều chỉnh khoảng cách giữa các dòng  

  là hai ( Double ). 

 Ctrl + 5 Điều chỉnh khoảng cách giữa các dòng là 1.5 

 Ctrl + Z Hủy bỏ thao tác vừa chọn. 

 Ctrl + Y (F4) Gọi lại thao tác vừa thực hiện. 
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PHẦN III: PHƯƠNG PHÁP ĐẶT TAB, CHÈN KÝ TỰ, ĐỊNH 

DẠNG BULLETS AND NUMBERING 

I. PHƯƠNG PHÁP ĐẶT TAB. 

1. Giới thiệu Tab. 

- Dấu tab là một ký tự đặc biệt được đặt lên thanh kích thước cho phép căn lề 

trái, lề phải một đoạn văn bản hoặc tạo các dòng kẻ gồm các ký hiệu dấu 

chấm(.),  hay gọi là định vị bước nhảy của con trỏ trên dòng văn bản. 

2. Cách tạo cộng cụ tab. 

- Đối với phiên bản Office Word 2003 ta chỉ cần lựa chọn Format/ chọn Tab. 

Bây giờ mình sẽ hướng dẫn các bạn lấy công cụ Tab đối với phiên bản Office 

Word 2007. 

+ Chọn Office Button/ chọn Word Oftions/ chọn thẻ Customize. Trong mục 

Choose commands from/ chọn All command/ chọn Tabs…/ chọn Add / OK. Giờ 

thì công cụ Tab đã xuất hiện trên thanh Ribbon. 

 

Hình 3.1 công cụ định dạng Tab 

3. Cách thiết lập Tab. 

- Đặt con trỏ vào vị trí cần đặt Tab. Trên thanh Ribbon / chọn  (Tab). Hộp 

thoại Format Tab: 

      Hình 3.2 hộp thoại định dạng Tab 
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- Tại mục Tab Stop Position:  Nhập điểm dừng của Tab. 

- Tại mục Alignment chọn: 

���� Left: Căn thẳng theo mép trái. 

���� Center: Căn thẳng từ giữa ra hai bên. 

���� Right: Căn thẳng theo mép phải. 

- Tại mục Leader: 

+  None:  Đường dẫn trắng. 

+ ………: Tab có đường nét chấm đính kèm. 

+ ----------: Tab có đường nét gạch đính kèm. 

+ Tab có đường nét liền đính kèm. 

- Tại mục Set: Định vị bước nhảy của con trỏ. 

- Tại mục Clear: Bỏ từng vị trí Tab đã thiết đặt. 

- Tại mục Clear all: xóa toàn bộ các vị trí Tab hoặc tổ hợp phím: Ctrl + Q. 

 CHÈN KÝ TỰ ĐẶC BIỆT SYMBOL

1. Giới thiệu về Symbol: 

+ Dùng để chèn các ký tự không có trên bàn phím. 

+ Ví dụ: Trong văn bản soạn thảo, trên bàn phím không thể gõ các ký tự hay 

biểu  tượng như: β, α, � …hay các ký hiệu toán học. 

2. Cách thực hiện. 

- Nháy chuột vào vị trí cần chèn. 

- Chọn Insert -> Symbol -> Chọn biểu tượng cần chèn -> chọn Insert -> Close. 

III. ĐỊNH DẠNG BULLETS AND NUMBERING: 

1. Giới thiệu về Bullets and Numbering. 

- Tạo ra các số thứ tự, ký hiệu tự động ở đầu mỗi đoạn văn bản. 
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2. Cách thực hiện lệnh định dạng Bullets and Numbering. 

- Bôi đen vùng văn bản cần tạo. Trên thanh Ribbon/ chọn thẻ Home -> chọn 

kiểu số hoặc ký tự sử dụng . 

 

 

Hình 3.3 công cụ định dạng Bullets and numbering 

IV. ĐỊNH DẠNG KHUNG VÀ MÀU NỀN. 

- Chọn phần văn bản cần tạo khung, tô màu nền. 

- Trên thanh Ribbon / chọn thẻ Page Layout / chọn Page Borders . 

 

 

Hình 3.4 công cụ tạo khung và màu nền 

� hộp thoại Borders and Shading xuất hiện: 

     

Hình 3.5 hộp thoại Borders and Shading 

a. Tại nhãn Border tạo khung cho đoạn văn bản 

- Setting: Chọn mẫu đường kẻ. 
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- Style: Chọn kiểu đường kẻ. 

- Color: Màu đường kẻ. 

- Preview: Quan sát từng đường kẻ và sử lý từng đường kẻ. 

- Apply to: Các xác nhận cho đoạn văn bản. 

b. Nhãn Page Border: Tạo khung cho cả trang. 

c. Nhãn Shading: Chọn màu nền. 

V. SAO CHÉP VÀ DI CHUYỂN VĂN BẢN. 

1. Sao chép văn bản. 
- Bôi đen vùng văn bản cần sao chép. Ấn tổ hợp phím Ctrl + C hoặc vào thẻ 

Home  -> Chọn   

2. Di chuyển dữ liệu. 
- Bôi đen vùng văn bản cần di chuyển. Ấn tổ hợp phím Ctrl + X hoặc vào thẻ 

Home  -> Chọn  

3. Dán dữ liệu. 
- Nháy chuột vào vị trí cần dán. Ấn tổ hợp phím Ctrl + V hoặc vào thẻ Home -> 

chọn  -> Paste. 
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PHẦN IV: CHIA CỘT, TẠO CHỮ THỤT CẤP ĐẦU ĐOẠN 

TÌM KIẾN VÀ THAY THẾ DỮ LIỆU 

I. CHIA CỘT. 

- Trên thanh Ribbon / chọn thẻ Page Layout / chọn Columns: 

   Hình 4.1công cụ chèn cột 

- Chọn số cột cần chèn, nếu số cột cần chèn lớn hơn thì chọn trong mục More 

Columns. Hộp thoại Columns xuất hiện: 

 

Hình 4.2 hộp thoại chèn cột 

- Trong ô Number of Columns: gõ số cột cần chia. 

- Muốn có đường kẻ ở giữa cột ta đánh dấu vào Line between. 

- Chọn OK. 

II. TẠO CHỮ THỤT CẤP ĐẦU ĐOẠN. 

1. Lấy công cụ Drop Cap. 
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+ Chọn Office Button / chọn Word Oftions / chọn thẻ Customize. Trong mục 

Choose commands from / chọn All command / chọn Drop Cap…/ chọn Add / 

OK. 

2. Sử dụng công cụ Drop Cap. 

- Cách 1: bôi đen chữ cần làm to đầu đoạn. Trên thanh Ribbon / Chọn Drop cap. 

 

Hình 4.3 công cụ tạo chữ Drop Cap. 

- Cách 2: Trên thanh Ribbon / chọn thẻ Insert / Chọn Drop Cap. 

+ Chọn kiểu khác trong mục Drop Cap Options. Hộp thoại Drop Cap xuất hiện: 

  

Hình 4.4 hộp thoại định dạng Drop Cap. 

- Font: Chọn Font chữ. 

- Lines to Drop: Điều chỉnh số dòng đổ xuống. 

- Distance from Tex: Khoảng cách từ chữ Drop Cap đến đầu đoạn văn. 

III. TÌM KIẾM VÀ THAY THẾ DỮ LIỆU. 

1. Tìm kiếm nhanh trong văn bản. 

- Trên thanh Ribbon / chọn thẻ Home  ->  chọn  hoặc sử dụng tổ hợp 

phím Ctrl + F. 
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- Trong mục Find What: gõ từ cần tìm -> chọn Find Next. 

2. Thay thế dữ liệu. 

- Trên thanh Ribbon / chọn thẻ Home  -> Chọn  hoặc sử dụng tổ hợp 

phím Ctrl + H. 

 

- Trong mục : +Find What: Gõ từ cần tìm 

 + Replace With: Gõ từ cần thay thế. 

 + Replace: Thay thế từng từ. 

 + Replace All: Thay thế toàn bộ. 

3. Truy cập nhanh tới một trang văn bản. 
- Trên thanh Ribbon / chọn thẻ Home -> Chọn: 

       hoặc sử dụng tổ hợp phím Ctrl + G. 

 

- Trong mục Enter page Number: Nhập số trang cần di chuyển tới -> sau đó 

chọn  Next. 
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PHẦN V: CHÈN HÌNH ẢNH, CHỮ NGHỆ THUẬT 

CHÈN SỐ TRANG TỰ ĐỘNG 

I. CHÈN HÌNH ẢNH. 

1. Chèn một Clip Art. 
- Trên thanh Ribbon / Chọn thẻ Insert -> chọn Clip Art.  Hộp thoại Clip Art 

xuất hiện bên phải cửa sổ làm việc. 

- Trong mục Search for -> chọn Go  -> Chọn hình ảnh cần chèn. 

2. Chèn chữ nghệ thuật Word Art. 

- Trên thanh Ribbon / chọn thẻ Insert -> chọn  xuất hiện hộp thoại: 

 

Hình 5.1 hộp thoại chèn chữ nghệ thuật WordArt 

Chọn kiểu mẫu chữ -> Nhập nội dung chữ cần chèn trong mục Edit Word Art 

Text -> Chọn OK. 

- Định dạng Word Art: Click phải chuột chọn Format Word Art. 

� Colors and lines: Chọn màu nền cho chữ. 

� Layout: Chọn định dạng hiển thị cho Word Art. 

3. Chèn một File ảnh từ ổ đĩa. 
- Trên thanh Ribbon / chọn thẻ Insert / chọn Picture 

 Xuất hiện hộp thoại Insert Picture. 
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Hình 5.2 cửa sổ chèn file ảnh từ ổ đĩa 

- Look in: Chọn nơi chứa hình ảnh. 

- File name: Tên File ảnh cần chèn. 

- File of Type: Kiểu định dạng File ảnh. 

- Insert: Chèn đối tượng tranh vào văn bản. 

4. Định dạng hình ảnh. 
- Nhấp chuột phải vào bức tranh chọn Format picture -> hộp thoại Format 

picture xuất hiện: 

 Hình 5.3 hộp thoại Format picture 



Giáo Trình Microsoft Word 2007 Design: Thanhtusydney@gmail.com 

      - 23 -

- Fill: Định dạng màu nền cho picture 

- Line Color: Định dạng màu cho đường viền. 

- Line Style: Chọn kiểu đường viền. 

- Shadow: Định dạng độ bóng. 

- 3D_Format: Định dạng 3D. 

- 3D_Rotation: Chọn góc quay cho Picture 

- Picture: Định dạng cho picture. 

- Text Box: Định dạng hộp thoại text box. 

5. Chèn số trang tự động trong văn bản. 
- Trên thanh Ribbon / Chọn thẻ Insert / chọn Page Number. 

 Hình 5.4 công cụ chèn số trang tự động 

� Chọn vị trí đặt số trang. 

- Đinh dạng kiểu số trang trong mục Format Page Number -> Cửa sổ Page 

number Format xuất hiện: 

 Hình 5.5 hộp thoại Page number Format 

 + Number Format: Định dạng kiểu số trang. 

 + Start at: Số của trang đầu tiên. 

Vị trí đặt số trang 
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PHẦN VI:BẢNG BIỂU VÀ MỘT SỐ THAO TÁC VỚI BẢNG BIỂU 

I. PHƯƠNG PHÁP TẠO BẢNG BIỂU. 

- Nhấp chuột vào vị trí cần đặt bảng biểu. 

- Trên thanh Ribbon / chọn thẻ Insert / chọn Table -> Hộp thoại: Insert Table 

xuất hiện. 

- Number of Columns: Nhập số cột cần 

tạo. 

- Number of Rows: Nhập số dòng cần tạo. 

- Chọn OK 

 

 

 

Hình 6.1 hộp thoại chèn bảng biểu 

 

II. MỘT SỐ THAO TÁC VỚI BẢNG BIỂU. 

1. Chèn thêm cột, dòng, ô. 
- Chèn cột: Đặt con trỏ vào vị trí cột cần chèn. Click phải chuột chọn  -> Insert 

“�” 

“�”= Columns to the Left: Chèn một cột trắng về phía bên trái vị trí con trỏ. 

“�”=Columns to the Right: Chèn một cột trắng về phía bên phải vị trí con trỏ. 

- Chèn dòng: Đặt con trỏ vào vị trí dòng cần chèn. Click phải chuột chọn  -> 

Insert “�” 

“�”=Rows Above: Chèn dòng trắng về phía trên dòng đặt con trỏ. 

“�”= Row Below: Chèn dòng trắng về phía dưới dòng đặt con trỏ. 

- Chèn ô: Nhấp phải chuột vào bảng. Chọn Insert ->Insert Cell xuất hiện hộp 

thoại. 
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 Hình 6.2 hộp thoại chèn ô 

 ���� Shift cell Right: Chèn một ô về phía phải vị trí con trỏ. 

 � Shift cell Down: Chèn thêm một ô về phía dưới vị trí con trỏ. 

 � Insert entire row: Chèn thêm một dòng về phía trên vị trí con trỏ. 

 � Insert entire Column: Chèn thêm một cột về phía trái vị trí con trỏ. 

 � OK. 

2. Xóa dòng, cột, ô. 
- Nháy phải chuột vào vị trí cần xóa. Chọn Delete Cell: Xuất hiện hộp thoại: 

 Hình 6.3 hộp thoại xóa ô 

���� Shift cells Left: Xóa một ô và dịch chuyển các ô bên phải sang ô vừa xóa. 

���� Shift cell up: Xóa một ô và dịch chuyển các ô phía dưới lên ô vừa xóa. 

���� Delete entire Row: Xóa dòng lựa chọn. 

���� Delete entire Column: Xóa cột lựa chọn. 

3. Trộn ô và tách ô: 
- Trộn ô: Bôi đen các ô cần gộp. Click phải chuột chọn Merge cell. 
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- Tách ô: Chọn ô cần tách. Click phải chuột chọn Split Cell hoặc Vào Table 

Tools-> Layout -> Chọn Split Cell. Xuất hiện hộp thoại : 

 � Number of Columns: Nhập số cột muốn tách ra. 

 � Number of Rows: Gõ số dòng cần tạo. 

 � OK. 

- Chú ý: Nếu tách bảng vào Table Tools -> Layout -> chọn Split Table. 

4. Một số thao tác với bảng biểu. 

Tab Đưa con trỏ đến ô tiếp 

Shift + Tab Đưa con trỏ trở về ô trước đó 

Alt + Home Đưa con trỏ về ô đầu của dòng hiện tại 

Alt + End Đưa con trỏ trở về ô cuối của dòng hiện tại 

Alt + Page Up Đưa con trỏ trở về ô đầu tiên của cột hiện tại 

Alt + Page Down Đưa con trỏ trở về ô cuối của cột hiện tại 

*/ Tab là phím có hai chức năng: 

+) Đưa con trỏ đến ô tiếp 

+) Tạo thêm dòng với điều kiện con trỏ phải đặt ở ô cuối cùng và nằm 

ở góc phải của bảng biểu. 

5. Phương pháp tính toán trong Word. 

- Nháy chuột vào vị trí cần hiển thị kết quả 

- Vào Table Tools �chọn Layout -> chọn Formula: 
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� Formula: Gõ lệnh thực hiện tính toán. 

� Number Format: Định dạng kiểu kết quả hiển thị. 

� Paste Function: Lựa chọn hàm. 

Một số lệnh cơ bản: 

� SUM(LEFT): Tính tổng các trị số bên trái con trỏ. 

� SUM(RIGHT): Tính tổng các trị số bên phải con trỏ. 

� SUM(ABOVE): Tính tổng các trị số bên trên con trỏ. 

� SUM(BELOW): Tính tổng các trị số bên dưới con trỏ. 

*/ Chú ý : Khi sử dụng các lệnh cơ bản như trên thì các trị số tính 

toán phải liên tiếp nhau, không được phép ngắt quãng. 

6. Phương pháp xắp xếp dữ liệu trong bảng biểu. 

- Bôi đen bảng cần sắp xếp 

- Vào Table Tools �chọn Layout -> chọn Sort xuất hiện hộp thoại: 

� Sort By: Chọn cột cần sắp xếp 

� Type: Kiểu dữ liệu cần sắp xếp (tự động chọn phù hợp với nội dung) 

 Text (kiểu văn bản), Number (kiểu số), Date (kiểu ngày) 

� Ascending: Sắp xếp theo chiều tăng dần. 

� Descending: Sắp xếp theo chiều giảm dần. 

� Chọn tiếp các cột khoá phụ tuỳ theo yêu cầu, lặp lại các bước đối với 

Then By. 

� OK. 
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PHẦN VII: SỬ DỤNG CÔNG THỨC TOÁN HỌC 

HỘP THOẠI TEXTBOX, VẼ BIỂU ĐỒ 

I. PHƯƠNG PHÁP TẠO CÔNG THỨC TOÁN HỌC. 

- Trên thanh Ribbon / chọn thẻ Insert � chọn Equation. 

 

 Hình 7.1 công cụ chèn công thức toán học 

II. SỬ DỤNG HỘP THOẠI TEXTBOX. 

1. Cách chèn Textbox. 
- Trên thanh Ribbon / chọn Insert � chọn Textbox. 

 

2.  Định dạng Textbox 

- Nháy chuột vào Textbox. 

- Vào Format � chọn Textbox, hoặc Click phải chuột chọn Format Textbox xuất 

hiện hộp thoại: 

+) Trong thẻ Colors and Lines: 

a. Fill Color: Chọn màu phù hợp (Nếu cần tạo hiệu ứng màu nền cho 

khung chọn Fill Efects và lựa chọn các thuộc tính phù hợp) 

b. Line: Color: chọn màu khung, Style: kiểu đường viền 

+) Trong thẻ Layout: 

Hình 7.2 công cụ Text box 
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i. Wrapping Style: Điều chỉnh chế độ của Textbox so với dữ liệu 

trên văn bản 

ii. In line with text: Đưa vùng dữ liệu lên phía trên và xuống dưới 

với đối tượng (không áp dụng với Textbox) 

iii. Square: Điều chỉnh vùng dữ liệu bao quanh Textbox theo hình 

vuông 

iv. Tight: Điều chỉnh vùng dữ liệu bám sát vào Textbox  

v. Behind text: Đẩy Textbox ra đằng sau vùng dữ liệu 

vi. In front of text: Điều chỉnh Textbox nổi lên trước vùng dữ liệu 

vii. Horizontal Alignment: Căn lề cho Textbox so với trang văn bản. 

III. VẼ BIỂU ĐỒ. 

1. Cách thức vẽ biểu đồ. 
- Trên thanh Ribbon / chọn thẻ  Insert ->  chọn Chart. 

 

 Hình 7.3 công cụ vẽ biểu đồ 

- Chọn kiểu biểu đồ -> OK 
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- Để thay đổi và định dạng cho biểu đồ lựa chọn Chart Tools / lựa chọn trong các 

thực đơn Design, Layout, Format. 

- Hoặc Click phải chuột vào biểu đồ xuất hiện các lựa chọn: 

+ Delete: xóa biểu đồ. 

+ Reset match Style: Reset kiểu chọn. 

+ Change series Chart type: Thay đổi kiểu biểu đồ. 

+ Edit Data…: Hiệu chỉnh dữ liệu trong biểu đồ. 

+ 3-D rotation: Các định dạng xoay biểu đồ, định dạng 3-D…… 

+ Add Data lables: Thêm các nhãn cho biểu đồ. 

+ Format Data Series: Định dạng cho các Series. 

 

PHẦN VIII: CÁC THAO TÁC NÂNG CAO TRONG VĂN BẢN 

TRỘN THƯ VÀ IN ẤN VĂN BẢN 

I. MAIL MERGE. 

1. Mục đích của trộn thư trong văn bản. 
- Giả sử ta có một danh sách gồm có một trăm , hai trăm khách mời dự họp hay 

giấy báo dự thi, điểm thi hay giấy nhập học của một trường nào đó. Với một 

khối lượng dữ liệu lớn như vậy chúng ta không thể nhập tên từng khách mời 

hay từng học sinh trong đó. Vì vậy Word sẽ tự động làm việc đó và công cụ để 

làm việc đó là Mail Merge. 

2. Các bước thực hiện. 
a. Đầu tiên tạo một văn bản chính ( Main Document) có nội dung như sau: 

 GIẤY MỜI 

 

 Kính gửi Ông (bà):  (1) 

Địa chỉ: (2) 

Trân trọng kính mời Ông(bà): (3) 

Là phụ huynh em: (4) 
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b. Tạo một tệp (Data Source) chứa những nội dung cần chèn. 

Họ tên học sinh Họ tên phụ huynh Địa chỉ 

Nguyễn văn A Nguyễn văn B TP Hải Dương 

Trần văn C Trần anh D H. Cẩm Giàng 

c. Thực hiện: Mở File văn bản chính( Main Document). 

- Trên thanh Ribbon / chọn Maillings / chọn Start Mail Merge -> Chọn Step by 

Step Mail Merge Wizard. 

 � Nhấp chuột chọn Letter và Click chọn vào Step 1 of 6 chuyển sang bước 2. 

 � Nhấp chuột chọn Next : Select… chuyển sang bước 3. 

 � Chọn vào Browse… Chọn tìm đến tệp Source Document.-> Open -> OK. 

- Trên thanh Ribbon / chọn Maillings / Chọn Insert Merge Field. 

 � Thực hiện thao tác trộn từng đối tượng từ tệp Source Document vào tệp 

Main Document. 

 � Chọn Next để hoàn thành các thao tác trộn thư. 

II. BẢO VỆ VÀ IN ẤN VĂN BẢN. 

1. Bảo vệ. 
- Trên thanh Ribbon / chọn thẻ Developer / chọn Protect Document / 

chọn Restrict Formating and Editing / chọn Yes, Start enforing 

Protection / Chọn mật khẩu / OK. 

- Hoặc chọn Prepate / chọn Encrypt Document / chọn OK. 

2. In ấn văn bản. 
- Chọn Office Button  -> Print hoặc sử dụng tổ hợp phím Ctrl + P hộp thoại Print 

xuất hiện: 
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- Name: Chọn máy in phù hợp. 

- All: In tất cả trang dữ liệu hiện thời. 

- Current Page: Chỉ in trang hiện thời. 

- Page: In trang theo chỉ định của người dùng. 

- Number of Copies: Số trang muốn sao chép. 

- Print What: Chọn nội dung in. 

- Document: In tài liệu. 

- Style: in các kiểu trình bày. 

+Trong mục  Print: 

- All pages in range: In toàn bộ các trang trong phạm vi lựa chọn. 

- Odd pages: Chỉ in các trang lẻ. 

- Even pages: chỉ in các trang chẵn. 
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ẦN XIX: BÀI TẬP THỰC HÀNH 

 Bài tập số 1 

  ®«i dÐp®«i dÐp®«i dÐp®«i dÐp    

  --- 000 --- 

 

µi th¬ ®Çu anh viÕt cho em 

Lµ bµi th¬ anh kÓ vÒ ®«i dÐp 

 Khi nçi nhí ë trong lßng da diÕt 

  Nh÷ng vËt tÇm th−êng anh còng viÕt thµnh th¬ 

 Hai chiÕc dÐp gÆp gì tù bao giê 

 Yªu nhau chØ mµ ch¼ng rêi nöa bưíc 

 Cïng g¸nh v¸c nh÷ng nÎo ®êng xu«i ng−îc 

 Lªn th¶m nh−ng xuèng c¸t bôi cïng nhau  

  Cïng bưíc, cïng mßn, kh«ng kÎ thÊp ngêi cao 

  Cïng chia sÎ søc ng−êi chµ ®¹p 

  DÉu vinh nhôc kh«ng ®i cïng ng−êi kh¸c 

  Sè phËn chiÕc nµy phô thuéc chiÕc kia    

 NÕu ngµy nµo mét chiÕc dÐp mÊt ®i 

 Mäi thay thÕ ®Òu trë nªn khËp khiÔng   

 Gièng nhau l¾m nh−ng mäi ng−êi ®Òu biÕt 

 Hai chiÕc nµy ch¼ng ph¶i mét ®«i ®©u 

   CòngCòngCòngCòng    nhnhnhnh−−−−    m×nh trong nh÷ng lóc v¾ng nhaum×nh trong nh÷ng lóc v¾ng nhaum×nh trong nh÷ng lóc v¾ng nhaum×nh trong nh÷ng lóc v¾ng nhau    

            BBBBíc hôt hÉng cø nghiªng vÒ mét phÝa íc hôt hÉng cø nghiªng vÒ mét phÝa íc hôt hÉng cø nghiªng vÒ mét phÝa íc hôt hÉng cø nghiªng vÒ mét phÝa     

            DÉu bªn c¹nh ®· cã ngDÉu bªn c¹nh ®· cã ngDÉu bªn c¹nh ®· cã ngDÉu bªn c¹nh ®· cã ngêi thay thÕêi thay thÕêi thay thÕêi thay thÕ    

            Mµ trong lßng nçi nhí cø chªnh vªnhMµ trong lßng nçi nhí cø chªnh vªnhMµ trong lßng nçi nhí cø chªnh vªnhMµ trong lßng nçi nhí cø chªnh vªnh....    

 The end! 

  BBBB
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 Bài tập 2. 

 bé gi¸o dôc & ®µo t¹o  Céng hoµ x$ héi chñ nghÜa ViÖt Nam  

 Tr−êng §HSP Hµ Néi  §éc lËp - Tù do - H¹nh phóc  

      ��	   

 

  GiÊy b¸o tróng tuyÓn  

  Tr−êng §¹i Häc s−  ph¹m Hµ Néi  

  

 Xin th«ng b¸o víi thÝ sinh: ......................................................................................  

 Sinh ngµy: ................................................................................................................  

 Sè b¸o danh :……............®$ tróng tuyÓn vµo Khoa To¸n - §¹i häc S− ph¹m Hµ 

Néi víi sè ®iÓm ®$ ®−îc lµ: 

 §iÓm To¸n :………, §iÓm Lý :………., §iÓm Ho¸ :………… 

  Tæng sè ®iÓm lµ: ……………… 

 §óng 8 giê s¸ng ngµy 18 th¸ng 9 n¨m 2010 thÝ sinh cã mÆt t¹i héi tr−êng nhµ 

A1, ®Ó lµm thñ tôc nhËp häc. Khi ®i mang theo hå s¬ bao gåm: 

 1. GiÊy b¸o tróng tuyÓn  

 2. Häc b¹, b»ng tèt nghiÖp THPT (giÊy chøng nhËn tèt nghiÖp t¹m thêi ) 

 3. B¶n sao GiÊykhai sinh. 

 4. S¬ yÕu lÝ lÞch. 

 5. 4 ¶nh 4x6. 

 6. TiÒn häc phÝ 3th¸ng ®Çu 900.000VN§. 

    NÕu sau ngµy 18 th¸ng 9 n¨m 2010 thÝ sinh kh«ng cã mÆt t¹i tr−êng ®Ó nhËp häc 

thÝ sinh sÏ bÞ huû bá kÕt qu¶, nhµ tr−êng sÏ gäi thÝ sinh kh¸c ®Ó thay thÕ  

  Hµ néi, ngµy … th¸ng …n¨m ..….  

  HiÖu tr−ëng  

  (§� k ý ) 
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3.  Bài tập số 3 

 CỘNG HÒA XÃ HỘI CHỦ NGHĨA VIỆT NAM 

Độc lập – Tự do – Hạnh phúc 

 

ĐƠN XIN VIỆC 
 

Kính gửi : ....................................................................................................  

 .....................................................................................................................  

Tôi tên là : .........................................................................................................  

Sinh ngày: ............... tháng: ....... năm: ......... tại: ..............................................................  

Giấy chứng minh nhân dân số: ........................................................................................  

Cấp ngày: ................ tháng: ....... năm: .........  tại: .............................................................  

Hiện cư ngụ tại : ..............................................................................................................  

Trình độ văn hóa : ............................................................................................................  

Ngoại ngữ:  + Anh: ......................................................................................................  

   + Pháp: .....................................................................................................  

Nghề nghiệp chuyên môn : ..............................................................................................  

Tình trạng sức khỏe : .......................................................................................................  

 Hiện nay chưa có việc làm, tôi làm đơn này xin Nhà nước tuyển dụng và bố trí 

công việc cho tôi. 

 Nếu được Nhà nước thu nhận tôi xin cam đoan thực hiện các công việc được giao 

và thực hiện các chủ trương chính sách chế độ, nội quy, kỷ luật của cơ quan xí 

nghiệp. 

 Kính mong được cơ quan xí nghiệp chấp nhận. 

   ................... , ngày ....... tháng ......... năm........  

  ( Ký tên ) 
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4..Bài tập số 4: 

Sử dụng công cụ chèn ch
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èn chữ nghệ thuật Word Art. 

Thanhtusydney@gmail.com 
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Bài tập số 5: 

Thiết kế Form giấy báo điểm thi và tiến hành gửi giấy báo cho danh sách 50 bạn thí 

sinh dự thi: 

3. Main Document. 

 BỘ GIÁO DỤC VÀ ĐÀO TẠO Cộng hòa xã hội chủ nghĩa Việt nam 

 TRƯỜNG ĐHQG HÀ NỘI Độc lập – Tự do – Hạnh phúc 

 

 

 PHIẾU BÁO ĐIỂM THI 
 Trường ĐHQG Hà Nội xin thông báo điểm thi đến: 

 Thí sinh: Sinh năm: SBD: 

 Hộ khẩu: Đối tượng: 

 Mã nghành: 

 Đã tham gia kỳ thi tuyển  sinh Đại học năm 2010 tại Trường ĐHQG Hà Nội với số 

điểm các môn như sau: 

 Môn toán: Môn lý: Môn hóa: 

 Tổng điểm:  

• Chú ý: chưa nhân hệ số và điểm cộng. 

 

2. Table Data Source. 

   BẢNG TRA THÔNG TIN 

Tªn 
N. 

sinh 
H khÈu §.tîng SBD 

M. 

Nghµnh 
To¸n Lý Ho¸ Tæng  

N.T.Anh 1992 H. D¬ng 2NT QG245 DTVT 7 8 8 23 

L.T.Anh 1992 H. Néi KV1 QG246 KTDN 7 9 3 19 

H.§.Bëi 1991 H. Phßng KV1 QG247 QTKD 7 5 7 19 

N.Q.Cêng 1990 Q. Ninh KV3 QG248 TDH 9 6 6 21 

 

- Hướng dẫn sử dụng các phương pháp: sử dụng tab, Table, Mail merge . 
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Bài tập 6: 

Thiết kế bảng biểu và tính các thành phần trên nó: 

 

TRUNG TÂM ANH 

NGỮ SYDNEY 

Tel: 03206.282528 

Hãa ®¬n  

kiªm phiÕu xuÊt 

Sè…………………… 

Ngµy…..th¸ng…..n¨m 2010 

MÉu sè O – VT 

§Þnh kho¶n 

Nî  

Cã  

 

Tªn kh¸ch hµng ............................................................................................................  

§Þa chØ ..........................................................................................................................  

Theo hîp ®ång sè ................................................ ngµy …….th¸ng…….n¨m 2010 

 

STT TÊN HÀNG 
ĐV 

TÍNH 
SL ĐƠNGIÁ 

THÀNH 

TIỀN 

GHI 

CHÚ 

I Trang thiÕt bÞ      

1  Mµn h×nh ChiÕc 10 112 ? USD 

2  Bµn phÝm C¸i 32 9 ? USD 

3  Mouse Con 85 3 ? USD 

4  Ram Thanh 18 35 ? USD 

Tæng ? ? ? ? USD 

II V¨n phßng      

1  Bµn m¸y C¸i 10 250000 ? VNĐ 

2  Bµn v¨n phßng C¸i 4 180000 ? VNĐ 

3  GhÕ gÊp C¸i 16 120000 ? VNĐ 

4  GhÕ xoay C¸i 3 270000 ? VNĐ 

Tæng ? ? ? VNĐ 

 

B»ng ch÷ ......................................................................................................................  
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Ng−êi nhËn Thñ kho Thñ quü KÕ to¸n Gi¸m ®èc 

 

 

 

 

Yªu cÇu thùc hiÖn 

1. Tr×nh bÇy b¶ng theo ®óng mÉu vµ thay ®æi kiÓu ®−êng viÒn vµ mÇu nÒn tuú ý 

2. TÝnh cét thµnh tiÒn 

3. TÝnh cét tæng céng ( Chó ý víi cét thµnh tiÒn trang thiÕt bÞ ph¶i quy ®æi ra tiÒn 

VN§ víi tû gi¸ lµ 19252). 
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7. Bài tập số 7. 

 

 

Khu Du LÞch §Çm Sen  

H©n H¹nh §ãn TiÕp QuÝ Kh¸ch 

 

� S¸ng mång 1 TÕt khai tr−¬ng Non Bé khæng lå cao 20m 

víi hµng tr¨m loµi c¸ biÓn, c¸ mËp, san h«, h¶i qïy sèng 

tù nhiªn trong n−íc.   

� Mét V−ên Hoa rùc rì kh«ng thua v−ên hoa §µ L¹t. 

§Æc biÖt: 

� Ph¸o b«ng truyÒn thèng §Çm Sen hoµnh tr¸ng diÔm lÖ 

gi÷a mÆt hå lung linh bãng n−íc. 

� Nh¹c trÎ: Ba Con MÌo - Sao vµng - H¹c Kim- Alta. 

� Héi Hoa §¨ng rùc rì vÒ ®ªm trªn hå sen di ®éng, c¸ 

chÐp lê l÷ng cña rång con phun löa... lung linh k× ¶o trªn 

mÆt n−íc. 


 Mång 1 §Õn Mång 8 � 

• C¸c lo¹i ho¹t ®éng v¨n hãa, v¨n nghÖ thuËt ®Æc s¾c: Rèi 

N−íc, DiÒu GiÊy, Móa Rèi - Ch−¬ng tr×nh v¨n nghÖ 

chuyªn nghÖp víi c¸c ng«i sao ca nh¹c, s©n khÊu, ®iÖn 

¶nh. 

• C¸c trß ch¬i thiÕu nhi phong phó míi l¹. 

Ch−¬ng tr×nh §Çm Sen ch¾c ch¾c sÏ lµm hµi lßng Quý kh¸ch! 

Yªu cÇu thùc hiÖn: 

1. So¹n th¶o v¨n b¶n theo mÉu trªn. 

2. Sö dông thanh c«ng cô Drawing ®Ó vÏ c¸c ®èi t−îng h×nh ®Æc biÖt. 

Quý 

M

Chóc 
mõng 
n¨m 
míi! 

Bính 
dần 
2010 

8 Ngµy 

Vui 

TÕt T¹i 

Khu 


